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Welcome and key features
This document provides information on how to use the TSOVu™ software platform to operate your TSO 8 Series sampling
oscilloscope. The 8 Series disaggregated platform provides you with a scalable, reconfigurable sampling oscilloscope with
up to 4 channels of simultaneous acquisition (with two 2-channel modules installed). The 8 Series consists of:

• TSO820 mainframe: Sampling oscilloscope mainframe
• TSOVu software: Application installed on 64-bit Windows 10 PC, connects to a TSO820 mainframe
• TSO8C17, TSO8C18: Available optical modules to be installed in mainframe

The 8 Series is an equivalent time sampling oscilloscope suitable for use in a variety of test and measurement applications
and systems. The mainframe must be configured with at least one of the above optical sampling modules. The 8 Series
supports optical device characterization at 56 GBd and 28 GBd at up to 30 GHz bandwidth (determined by the bandwidth of
installed modules).

Key performance specifications
• Low time base jitter
• Optical bandwidth above 30 GHz
• Single mode and multi-mode support for short and long wavelength optical testing
• Optical Reference Receiver (ORR) support for standard-mandated compliance testing

New system architecture
• Disaggregated architecture separates acquisition hardware and software analysis, allowing data to be streamed over

Ethernet to any connected PC running TSOVu™ . Scale your analysis platforms to fit your needs and connect from
anywhere on the network.

• Swap modules for various configuration.

Optical modules
• Accurate testing and characterization of short or long wave optical signals using the high sensitivity and low noise

performance of the TSO8C17 or TSO8C18 modules.
• Optical Reference Receivers (ORR) to support specified requirements for standards mandated compliance testing.
• Calibrated extinction ratio measurements and variable correction ER measurements to ensure accuracy and

repeatability.

Analysis with TSOVu™
• The TSOVu™ software platform runs independent of the oscilloscope mainframe on your PC to support both live and

post-processing of acquired data.
• Offers comprehensive analysis of PAM4 optical signals. Includes support for eye diagrams, optical measurements such

as TDECQ, and other standard measurements. Measurements like PAM2 / NRZ are also available.
• Measurement includes a plug-in interface. User-defined measurements are added directly to the TSOVu™ interface to

increase flexibility and productivity.

High test throughput
• High sample acquisition rate at 300 kS/s per channel standard
• Sophisticated Programmatic Interface (PI) for automation environments to enable the highest test throughput. Each

command supports full data synchronization, eliminating the need to wait / sleep statements.

Get started
Start with the Initial setup topics for a quick start guide to initial signal acquisition and configuration. For an overview of the
instrument user interface and controls, see the Introduction to mainframe and modules topic.

Welcome and key features
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How to find help topics
This Help provides context-sensitive topics with information about the various features and capabilities to the 8 Series.
When any badge or screen is active in TSOVu, select Help to view the topic related to that item.

You can also select Help from the TSOVu main menu bar to open the Help file. Select one of the following tabs to search for
topics:

• Contents. Click any entry to display information on the subject.
• Index. Double-click an entry to display information on the subject; or, enter a keyword you are looking for (the list scrolls

to that topic). Click Display to open the topic.
• Search. Type in the keyword you are looking for and then click List Topics. Every topic that contains the keyword will be

displayed. Double-click a topic to open it, or select a topic, and then click Display to open it.

Need extra help?
If you cannot find the information that you are looking for in this Help, check the Available product documentation
on page 4 topic for a list of other product related documents. You can also contact Tektronix technical support at
www.tek.com (select Support from the main menu) for help with operating your instrument.

Welcome and key features
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Product support and feedback
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or
comments on your instrument, application, or product documentation.

Contact us through mail, telephone, or the website. See Contacting Tektronix on page 0  for more information or
assistance with your product.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible):

General information
• All instrument model numbers
• Hardware options, if any
• Modules used
• Your name, company, mailing address, phone number, FAX number
• Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information
• Software version number
• Description of the problem such that technical support can duplicate the problem
• If possible, save and send the setup files for all the instruments used and the application
• If possible, save and send status messages text files
• If possible, save and send the waveform on which you are performing the measurement as a .wfm file

Product support and feedback
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Available product documentation
The following documents for the TSO8 Series are available for download. For the most recent versions these documents,
visit the Tektronix Web site at www.tek.com. You can find manuals by searching on the product name and selecting the
Manuals filter.
To learn about Use this document
How to install and turn on the
instrument software and hardware; read
safety and compliance information

TSO8 Series Installation and Safety Instructions

Printed and shipped with the instrument. Also available online as a downloadable
PDF. This document contains content in English, Japanese, and Simplified
Chinese.

How to operate the instrument, take
measurements, and navigate the UI.

TSO8 Series Help

Available in the TSOVu application (Help menu) and as a downloadable PDF at
www.tek.com.

How to remotely control the instrument
using GPIB programmatic commands.
Syntax provided.

TSO8 Series Programming Manual

Mainframe and module specifications.
Includes procedures to verify that the
mainframe and modules meet
warranted specifications.

TSO8 Series Specifications and Performance Verification Technical Reference

Installing up to two mainframes, or one
mainframe and one TCR801 clock
recovery unit, into a standard
instrument rack using the rackmount kit.

8 Series Rackmount Kit Instructions

How to declassify, sanitize, and clear
memory devices in the instrument.

TSO8 Series Declassification and Security Instructions

Available product documentation
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Available application notes and demo guides
Available for download on www.tek.com.

• Taking IEEE 802.3 bs/cd optical measurements

This demonstration guide walks you through how to take IEEE 802.3 bs/cd optical measurements.
• Physical Layer Tests of 100 Gb/s Communications Systems

This application note shows you how to prepare for compliance measurements on 100G standards including
IEEE802.3ba/bj/bm and the tests for optical, electrical, or PAM4 transmitters and receivers that help diagnose
noncompliant components and systems.

• PAM4 Signaling in High Speed Serial Technology: Test, Analysis, and Debug

This application note presents information on testing PAM4 technology and approaches for validating PAM4 signals. It
describes PAM4 technology for 50-400G applications, details of PAM4 signaling, outline of the important aspects of
evaluating electrical and optical transmitters, and an explanation of methods for evaluating PAM4 receivers and more.

Available application notes and demo guides
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Tektronix Learning Center, YouTube, and Blog
You can browse the Tektronix YouTube channel, Tektronix Blog, and the Tektronix Learning Center to access all the latest
online tutorials and resources, from primers and white papers to demos and webinars, to help you grow your expertise.

Finding the Tektronix Learning Center
Select Support > Learning Center Tutorials to access the Tektronix Learning Center. You can browse tutorials by product
family and view the top 5 downloads.

Searching for topics on the Tek YouTube channel
Go to www.youtube.com/tektronix to find video tutorials about various topics related to your product and applications. You
can subscribe to the Tektronix YouTube channel to keep up with new postings.

For example, you can watch a video demonstration of eye diagram measurements on 25Gb/s data transmission over single-
mode and multi-mode fiber. To find a video on a topic, do the following. (The following image shows you what the Tektronix
YouTube Channel looks like.)

Tektronix Learning Center, YouTube, and Blog
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1. Click on the search icon located next to About.

This icon allows you to search the Tektronix YouTube channel specifically. The search icon located at the top of the page
allows you to search all of YouTube.

2. Type in the key phrase you are looking for in the search field. For example, "optical measurements".
3. Click the search icon to start the search.
4. Videos related to the topic will appear. Click a video to view it.

Finding the Tektronix Blog
Search for "blog" on www.tek.com to see what's new and what is happening in the Tektronix community. You can also
search for postings from our experts.

Tektronix Learning Center, YouTube, and Blog
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Introduction to mainframe and modules
Front panel

The front panel of your instrument gives you access to the following.

Num
ber

Item Description

1 Power button Turn on/off power to instrument and installed modules. Blue indicates power is on. Amber
indicates standby power is on.

2 LCD display Shows MAC and IP addresses. Navigate using scroll/select buttons. 61 mm (W) x 12 mm (H)
x 2x20 liquid crystal display (LCD).

3 Slot 1 Slot for module.
4 Slot 2 Slot for module.
5 Keypad buttons Scroll/select buttons to navigate LCD display.
6 Clock Prescale

Input
2.92 mm. 50 Ω, AC-coupled, divide-by-one/two/four/eight external trigger input port, enabling
direct or prescaled triggering for clocks in the frequency range of 500MHz - 32 GHz.

7 Antistatic
connection 1MΩ

A banana-jack antistatic connection of 1 MΩ to ground.

Rear panel
The rear panel of your instrument gives you access to the following.

Introduction to mainframe and modules
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Num
ber

Item Description

1 Security cable
slot

Security cable can be attached to secure instrument to a physical location.

2 Module vents Provides airflow for installed modules. There is one fan in each module slot.
3 USB port USB 3.0
4 Mfg port Not for use.
5 LAN port 10/100/1000 Gb Ethernet
6 Side feet The side feet (4) protect the product when placed on its side. Do not use this equipment while

turned on if the instrument is sitting on its side feet.
7 Power Input voltage: 100 - 240 V, 115 V

Frequency: 50 - 60 Hz, 400 Hz
Power: 200 W max

8 Rear feet The rear feet (4) are for preventing damage of connected cables or power cord if those are
connected and the instrument is placed on its rear. Do not use this equipment while turned on if
the instrument is sitting on its rear feet.

9 Handle Carrying handle.

Warning: Do not use this equipment while turned on if the instrument is sitting on its rear feet. This can prevent
proper air flow.

Electrostatic discharge information
Read the electrostatic discharge (ESD) Read This First document that shipped with the mainframe and module for complete
information about how to prevent damage to the modules and mainframe due to ESD. Following is some of that information.

CAUTION: To prevent damage to the instrument and electrical modules from electrostatic discharge (ESD), install
50 Ω terminations on the module connectors before removing them from the mainframe or when it is not in use.

CAUTION: Store modules in static-free containers. Whenever you move a module from one instrument to another,
use a static-free container in which to transport it. This will help prevent damage due to ESD.

Introduction to mainframe and modules
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CAUTION: To prevent damage to the electrical module, discharge to ground any electrostatic charge that may be
present on the center and outer conductors of cables before attaching a cable to a module.

CAUTION:

To prevent damage to the modules, always wear a grounded antistatic strap (provided with the instrument) when
handling modules or making connections. Wear anti-static clothing and work at a static-free workstation when using
the modules.

Module installation and removal
Procedure for installing and removing modules.

The TSO820 sampling oscilloscope allows for installation of the following two modules. For detailed specifications
information, see the TSO820, TSO8C17, TSO8C18 Sampling Oscilloscope and Modules Specifications and Performance
Verification manual available for download on www.tek.com.

• TSO8C17, 1 channel 28 GBd / 53 GBd
• TSO8C18, 2 channel 28 GBd / 53 GBd

CAUTION: Only qualified personnel should perform the following procedures. Ensure power is off to the unit before
installing or removing modules.

CAUTION: To prevent damage to the modules, wear a grounded antistatic strap when removing and installing
modules and cables connected to modules.

Install a module
CAUTION: Do not hot swap modules. Installing or removing modules into/from the mainframe with the power on
will damage the module. To avoid damage, turn off the power before installing or removing a module.

1. Power off the mainframe.
2. Use a flathead screw driver to loosen the two latch screws that secure the top cover to the mainframe and lift off the

cover.

Introduction to mainframe and modules
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3. Notice that the mainframe ships with one filler module installed. This is a place holder that ensures proper air flow and
temperature stability when only one module is installed.

Before installing a module, remove the filler module from the side into which you want to insert the regular module by
loosening the securing screws (they are captive and stay attached to the filler module).

Never leave a module slot empty while the instrument is powered on and running. Always have a filler or regular
modules installed to ensure proper air flow and temperature stability.

4. Insert the desired module into the mainframe at an angle, as shown.
5. Push down lightly on the rear of the module to seat it securely into the mainframe. You will hear a click when it seats

fully.
6. Tighten the 4 attached screws to secure the module to the mainframe.
7. Replace the mainframe cover and use the driver again to turn the screw latches to secure it in place.

8. Before taking measurements, allow a minimum 30 minutes warmup and run a compensation.

Remove a module
CAUTION: Do not hot swap modules. Installing or removing modules into/from the mainframe with the power on
will damage the module. To avoid damage, turn off the power before installing or removing a module.

1. Power off the mainframe.

Introduction to mainframe and modules
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2. Use a flathead screw driver to loosen the two latch screws that secure the top cover to the mainframe and lift off the
cover.

3. Loosen the 4 screws that secure the module to the mainframe. These are captive screws and stay attached to the
module.

4. Grasp the rear of the module (as noted on the module) and pull up at an angle to unseat the module.
5. Lift the module from the mainframe at an angle to remove it.
6. Before powering on the mainframe, ensure a filler module or module is installed in the side from which you removed the

module.

The mainframe ships with one filler module installed. This is a place holder that ensures proper air flow and temperature
stability when only one or module is installed.

Never leave a module slot empty while the instrument is powered on and running. Always have a filler or regular
modules installed to ensure proper air flow and temperature stability.

7. Replace the mainframe cover and turn the screw latches to secure it in place.
8. Before taking measurements, allow a minimum 30 minutes warmup and run a compensation.

TSOVu user interface
The TSOVu application contains waveforms and plots, measurement readouts, and controls to access all oscilloscope
functions.

TSOVu display and navigation

The areas of the display as numbered in the previous image are as follows.

Introduction to mainframe and modules
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1
The Menu bar allows you access the following these menus and functions.

Menu Options Description
File Recall Recall setup, waveform, or session

files.
Save Save the current file.
Save As Waveform files (.wfm, .csv): a

waveform data file includes the
acquired waveform data. You can
select the file type, source, location,
and if you want to auto increment the
file name.

Checking the Auto Increment File
Name lets you save sequential files
without needing to manually rename
them each time. The count number is
added to the end of the file name.

The Count defaults to 000 if there are
no files at the specified location and file
name that already use incremented file
names. If there are files at the save
location that already use the specified
file name, and have already been
saved using count increments, the
Count field shows the next count value
that will be added to the file name when
the file is saved.

Setup files (.set): a setup file includes
all instrument settings and user
configured analysis. This allows you to
recreate the current setup on another
compatible instrument with newly
acquired data. You can select the file
name, location, if you want to auto
increment the file name, and if you want
to include all references.

Session files (.tss): a session file is a
zipped file that includes a setup file and
all acquired waveform data. This allows
you to move analysis activities offline.
You can select the file name, location,
and if you want to auto increment the
file name.

Default setup Stops acquisition and returns the
application to its default setup.

Exit Closes the TSOVu application.
Table continued…

Introduction to mainframe and modules
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Menu Options Description
Connect System Configuration Allows you to connect to the TSO820

instrument by entering the IP address
or host name. Once connected, this
screen shows the serial numbers of the
connected mainframe and module(s).

Utility Calibration Display instrument and module last
calibration date, temperature, and pass/
fail status.

Compensation Compensation controls allow you to run
compensation on the mainframe and
modules.

Diagnostics Shows the status of the power-on self
test and allows you to export log files.

Disable Error Pop-ups Click to check or uncheck this menu
item. Check it to disable error pop-up
messages from appearing on the
display. Uncheck to enable them.

When disabled, this icon shows on the
status bar:

Help Help Opens this navigable Help file.
About View installed options, licenses, and

SW versions. Install new licenses using
the About window.

2
Channel badges provide access to the vertical settings, optical settings, persistence, deskew, and external attenuation for
that specific channel.

See the Vertical configuration topic for details.

3
Status bar. Error messages will appear here. You can also disable error message pop-ups and a disabled icon will appear
on the status bar indicating that pop-ups are disabled.

Some badges display errors on the badge. TSOVu shows warnings and messages in the bar at the very bottom of the
application screen. Click More for the error details.

Introduction to mainframe and modules
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4
Horizontal configuration badge. Double click to access the configuration menu.

See the Horizontal configuration menu topic for details.

5
Trigger configuration badge. Double click to access the trigger configuration menu. See the Trigger configuration menu topic
for details.

6
Acquisition configuration badge. Double click to access the acquisition configuration menu. See the Acquisition
configuration menu topic for details.

7
Click button to start and stop signal acquisition. When there is no instrument connected to TSOVu, this button shows
"Offline".

8
Draw A Box for zoom or histogram button. This dual purpose button allows you to define zoom areas and histograms. See
the following topics for details: Draw a box for zoom or histogram, Add a histogram, and Zoom elements.

9
Measurement and histogram badges. These badges appear here below the Add New... panel. Double click a badge for
related configuration options. See the Add measurement and Add a histogram topics for details.

10
Use the buttons here to add measurements, cursors, notes on the display, histograms, and results tables. See these topics
for more details: Add measurement, Add cursors, Add a note to a view, Add a histogram, and Add Results Table.

11
Waveform view area. See the Waveform View configuration topic for details.

12
Zoom view and controls when zoom is defined and active. See the Zoom elements topic for details.

Introduction to mainframe and modules
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SW and FW Installation and network connection
Software installation and requirements

The following software is available for the 8 Series. The TSOVu base software enables mainframe connectivity and
operation, cursors, results tables, and other features. The base software package also includes the Pulse measurements
plug-in. Other plug-ins are available for purchase and download separately. 

PC system requirements
Install the software on a PC with the following specifications.

Item Requirement
Operating system Microsoft® Windows 10, 64 Bit
CPU Recommended: AMD Ryzen 7 or Intel i7 class CPU with 4 core / 8 thread

Minimum: AMD Ryzen 5 or Intel i5 with hyperthreading

Note that the time to calculate the TDECQ result is inversely proportionate to the clock speed.

Memory Minimum 16 Gbytes
Disk 256 GBytes SSD or more
Networking 1 Gigabit Ethernet wired

Other software requirements
You must install MATLAB® Compiler Runtime version 9.3 on to the host PC. Go to MathWorks (https://
www.mathworks.com/products/compiler/matlab-runtime.html) to download and install it.

Install TSOVu software
You must install the base software before installing any plug-ins. The downloadable package will include the base software
and the Pulse and PAM4 measurement plug-ins. The PAM4 plug-in is optional and requires a purchased license to enable
it. Install the software as follows.

1. Go to www.tek.com and click the Download icon.

2. Select Software, enter TSOVu, and click Search.

SW and FW Installation and network connection
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3. Find the most recent version of the TSOVu base software and download the package to the PC you will use to connect
with and control the mainframe.

4. Double click the .exe file to launch the install wizard. Follow the instructions to install the software. Your PC with
automatically restart when the installation is complete.

5. A TSOVu icon will install on the Windows Desktop. Click to launch the application.

The following items are installed with the base software package:

• TSOVu™

The application that runs on your PC and is the analysis engine and UI of the mainframe and modules. It is required to
connect to a mainframe.

• Pulse measurement plug-in

This plug-in comes standard with the base installation package and provides pulse measurement capabilities.
• PAM4 measurement plug-in

Use of this plug-in is optional. To enable it, you must purchase a license.
• TSO8 firmware
• TekVISA™

A library of industry-standard compliant software components, organized according to the standard VISA model
established by the VXIplug&play Systems Alliance. Use TekVISA software to write interoperable instrument drivers to
handle communicating between software applications and your instrument.

Install optional plug-ins
For a full list of optional plug-ins, see the Software licenses and options topic in the Help or view the TSO 8 Series product
datasheet on www.tek.com. Due to the plug-in architecture of TSOVu, measurement plug-ins must be installed prior to
TSOVu software launch. To purchase and download optional plug-ins, do the following.

1. Navigate to your TekAMS system account and purchase the desired plug-in(s).
2. Run the plug-in installer with administrative privileges and walk through the installation procedure for each measurement

plug-in.
3. Re-launch TSOVu.
4. Install the new plug-in license(s) from Help > About in the TSOVu application.

(See the Software licenses and options topic next for more information.)

See these TSOVu Help topics for more information:
Software licenses and options

Connect to network and TSOVu

Firmware installation and requirements

Run signal path compensation (SPC)

SW and FW Installation and network connection
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Software licenses and options
The TSOVu application is made up of the base software, Pulse measurement plug-in, and any additionally purchased plug-
in software (licensed optional software). The base package enables mainframe connectivity and operation, cursors, results
tables, pulse measurements, and other baseline features. It is free and available for download at www.tek.com\downloads. 

To install a license in TSOVu
1. Select Help > About from the TSOVu main menu bar to view installed options and system information.
2. Click the Install License button under the Installed Options table.
3. Select the appropriate install location:

a. TSOVu: The license will install on the PC. Anyone using that PC will have access to the license for any instruments
to which it connects.

b. Instrument: The license will install on the selected instrument. Any PC connecting to that instrument will have
access to license.

4. Click the Browse button to open a file explorer window and navigate to the location to which you saved the license file
from the Tek AMS system.

5. Click Open.
6. Click the Install button.

To copy system information (TSOVu SW version, host ID, plug-in versions)
1. Select Help > About from the TSOVu main menu bar to view installed options and system information.
2. Click the Copy System Information button under the System Information table.
3. The information from the table has been copied to a clipboard. You can now paste it into a document of your choice.

Plug-in options
The following optional plug-ins are available to add to the TSOVu base software. These plug-ins enable new capabilities.
For the most updated list of options, please view the TSO 8 Series datasheet at www.tek.com.

Plug-in description Option License
Measurements for PAM4 optical
signals. Enables TDECQ equalization
and analysis.

TSO8SW-NLP-PAM4-O License; PAM4 Optical Measurements;
Node-Locked Perpetual

TSO8SW-FLP-PAM4-O License; PAM4 Optical Measurements;
Floating Perpetual

TSO8SW-NL1-PAM4-O License; PAM4 Optical Measurements;
Node-Locked 1-Year subscription

TSO8SW-NL3-PAM4-O License; PAM4 Optical Measurements;
Node-Locked 3-Year subscription

TSO8SW-FL1-PAM4-O License; PAM4 Optical Measurements;
Floating 1-Year subscription

TSO8SW-FL3-PAM4-O License; PAM4 Optical Measurements;
Floating 3-Year subscription

License options
License types

• Perpetual: This license does not expire, but updates and support are available for a set time period. Support can be
renewed for an annual fee. When that annual subscription of the perpetual license expires, the software will be usable
but frozen to the last released version before the expiration date.

SW and FW Installation and network connection
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• Subscription: This license provides use, updates, and support of the software throughout the term of the license. When
the license expires, those software features will no longer work.

License terms

• Node-locked: License assigned to a specific instrument/PC. It cannot be transferred to any other instrument/PC.
• Floating: License can be transferred from one instrument/PC to another. It can only be used on one instrument/PC at a

time.

See these topics for more information:
Software installation and requirements

Connect to network and TSOVu

Available product documentation

Connect the mainframe to the network and TSOVu
To control the instrument with the TSOVu application, the instrument must be made available to the same LAN as the PC
hosting TSOVu. The oscilloscope has a standard Ethernet (RJ-45) interface for connecting to a network.

Use the included CAT6 Ethernet cable. If you use a different type of Ethernet cable, it must be a CAT6 or faster cable and it
should be consistent with the network speed you require.

1. Connect the CAT6 Ethernet cable to the LAN connector on the rear panel of the instrument.
2. Plug in the instrument power cord to the instrument and then a power source. The instrument will power on

automatically.
3. Press the right/left arrow keys on the mainframe front panel until you see IP address on the LCD display. Note the IP

address. Only DHCP addresses are supported.
4. Launch TSOVu.
5. In TSOVu, select Connect > System Configuration and enter the previously noted IP address.
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6. Press the green + button (or the Enter key on a keyboard) and the instrument will connect. Mainframe and modules
names and firmware versions will appear.
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Next steps:
See the Run signal path compensation (SPC) topic in the Help for instructions for running a SPC before connecting a signal
to view.

Firmware installation and requirements
Keep the mainframe firmware updated to ensure the latest features are available and the instrument is taking the most
accurate measurements. You can do this by downloading the latest firmware from www.tek.com and installing it yourself.
Module firmware can only be updated by the Tektronix service organization.

Before you begin
Determine the current version of firmware installed on the instrument using the front panel LCD screen menu.

Procedure
1. Download the instrument firmware to a USB drive:

a) Navigate to C:\Program Files\Tektronix\TSOVu_Firmware to locate the firmware that was downloaded to your PC
when you installed the TSOVu installation package.
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b) If the available firmware version is newer than what is on your instrument, select that file.
c) Copy the .img file to a USB memory device.

2. Install firmware on instrument:
a) Power on the instrument and wait for the instrument to fully boot up.
b) Insert the USB flash drive into the USB port on the instrument rear panel.
c) Cycle the power on the mainframe to begin the update process. The process status will appear on the front panel

LCD until finished.
d) The instrument will update the firmware and power on immediately following installation completion.
e) Remove the USB stick after the instrument has powered on successfully.

Note: Do not power off the instrument or remove the USB flash drive until the instrument finishes installing the
firmware. Remove the USB drive before powering on the instrument.

3. Confirm that the firmware was updated:
a) Check the Firmware version in the Firmware menu on the front panel LCD. It should now show the updated version.

Results
If an error occurs, try to reformat your USB drive. Navigate to Computer Management > Disk Management on your PC to
repartition the USB drive with the default allocation unit size.
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Initial setup
Run signal path compensation (SPC)

Run signal path compensation of the mainframe and optical modules at regular intervals for the best measurement
accuracy. You should run a compensation whenever the ambient (room) temperature has changed by more than 5 °C
(9 °F),

About this task
Compensation corrects DC inaccuracies caused by temperature variations. Failure to run a compensation on a regular
basis may result in the instrument not meeting warranted performance levels at low volts per division settings.

There are two nonvolatile compensation memory areas in the mainframe and for each channel within a sampling module,
referred to as Factory and User compensation memories. Also, there is a volatile, in-use memory version of all
compensation data, referred to as the run-time compensation memory, that holds the compensation data that is actually
used during operation of the instrument. On power-on, the instrument automatically retrieves the compensation data stored
in the nonvolatile User memories into the volatile run-time memory version.

Procedure
1. Run the mainframe SPC

a) Terminate the Clock/prescaler input with a 50 Ω terminator.
b) Power on and warm up the instrument for at least 20 minutes.
c) Ensure that the instrument is connected to TSOVu. In TSOVu, click Utility > Compensation and check the

Mainframe box.
The Compensation window opens.

d) Click the Compensate button.
A dialog window appears. Read the information in the dialog and ensure signals are disconnected/disabled and
trigger signals are handled appropriately.
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e) Click the OK button.
The SPC will run. This may take several minutes. The Compensation window shows you the results of the test. If
the instrument passed, a message appears in the lower left portion of the window stating compensation was
successful and the timestamp will be updated.

If the SPC fails, a pop-up error dialog will appear. Make sure that all cables are disconnected and run the SPC
again. If the SPC still fails, contact Tektronix Customer Support.

2. Run the module(s) SPC
a) Remove the 50 Ω terminator from the Clock/prescaler input.
b) Connect a clock signal to the Clock/prescaler input.
c) In TSOVu, click Utility > Compensation and check the Modules boxes.

This will check all of the channels under the selected modules.
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d) Click the Compensate button.
A dialog window appears. Read the information in the dialog and ensure that the mainframe SPC was valid and
trigger signals are handled appropriately.

e) Click the OK button.
The SPC will run. This may take several minutes. The Compensation window shows you the results of the test. If
the modules passed, the timestamp will be updated. If the SPC fails, a pop-up error dialog will appear. Make sure
that the clock signal is properly connected and run the SPC again. If the SPC still fails, contact Tektronix Customer
Support.

f) When the compensation process finishes, click the Cancel button to close the Compensation window.

Dark-level compensation
Dark-level compensation maximizes the accuracy of the extinction ratio and other optical automatic measurements.

If Dark Level Compensation is needed, run a module compensation.

Dark-level compensation maximizes the accuracy of the extinction ratio and other optical automatic measurements. Dark-
level compensation is not saved and is only valid for the selected bandwidth or filter path and the internal optical power
meter.

Connect a signal
After running compensation, connect an optical signal, such as a transceiver signal, to the module input to verify you can
see a signal.

After running compensation of the mainframe and modules, connect an optical signal, such as a transceiver signal, to the
module input to verify you can see a signal.

There are various ways to connect signals, depending on your application. Here are two examples.
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See these topics for more information:
Run signal path compensation (SPC)

Horizontal configuration

Vertical configuration

Horizontal configuration
Use the Horizontal Settings menu to select the acquisition mode (Pattern Sync), Symbol Rate, Pattern Length, and related
parameters.

To open the Horizontal Settings menu, double-click the Horizontal badge.

Ensure that the horizontal parameters match the input signal and that horizontal parameters are set accurately.

Initial setup

28



Horizontal Settings menu fields and controls
Field or control Description
Pattern Sync Toggle to turn pattern synchronization on and off. On is Pattern Mode acquisition. Off is eye

mode acquisition.

Symbol Rate Symbol Rate of the input signal.

Samples / UI

(Only available when Pattern
Sync is On)

Pattern Sync must be On for this field to be active. You can set the samples per unit interval
by typing in this field.

Data Clock Ratio Sets the ratio of the input signal data rate to the clock signal frequency applied through the
CLOCK PRESCALE INPUT connector.

Pattern Length

(Only available when Pattern
Sync is On)

Set the Pattern Length by selecting the pattern type from the drop-down list.

Selecting User Defined allows you to set any pattern length value.

Horizontal Scale With Pattern Sync on, this is a read only field that shows the current horizontal scale,
measured as s/div. With Pattern Sync off, you can change the value by typing in this field.

Record Length With Pattern Sync on, this is a read only field showing the number of samples to collect
given the current settings. With Pattern Sync off, you can change the value by typing in this
field.

Horizontal Reference

(Only available when Pattern
Sync is Off)

Shows the point around which channel waveforms expand and contract horizontally on
screen as you change the Horizontal Scale control.

Horizontal Position

(Only available when Pattern
Sync is Off)

The horizontal units are time. The horizontal position is the time between trigger and the
first point in the record.

Resolution This read only field shows the time between two samples (s).

Vertical configuration
Use the vertical configuration menu to set parameters such as vertical scale, wavelength, filter, and persistence.

Double-click on a channel badge (M1 or M2) to access the vertical configuration menu for the selected channel tab. This
menu provides access to the following channel settings.

• Vertical Settings
• Optical Settings
• Persistence
• Other (deskew and external attenuation)
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Table 1: Vertical Settings

Field or control Description
Display Toggles the selected channel On and Off.

Vertical Scale Set the vertical scale. Click the up and down arrows to change the scale or type in the
value in the field.

Table continued…
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Field or control Description
Offset Sets the channel signal vertical offset. Type the value that you want in the field.

Click Set to 0 to set the vertical offset to 0 Watts.

For more accurate measurements, set this to 400 μW for small signals (signals with
Average Optical Power (AOP) < 500 uW). You will never need to set the offset to < 400 μW
on the TSO8C17 and TSO8C18 optical modules. For signals > 400 μW, we recommend
setting the vertical offset to within 100 μW of the signal's AOP, which is particularly
important for the TDECQ measurement.

Position Sets the vertical position. Type the value that you want in the field.

Click Set to 0 to set the Position to 0 divisions.

Label Type in the field to add a label for the selected channel waveform. To modify an existing
label, double click on the label in the display to open the Label edit window.

Table 2: Optical Settings

Field or control Description
Wavelength Select a wavelength from the drop-down menu.

AOP Average Optical Power of the signal. Select dBm or Watts.

Filter Type You can select either a Hardware Filter (attach to the instrument) or a BWE Filter
(Bandwidth Enhancement).

Signal Type

(Only available when BWE
Filter is selected)

Select PAM4 or NRZ.

BW Electrical Select the appropriate bandwidth. This option depends on the data rate of the signal.

Filter Details Read only text shows you the filter details.

Table 3: Persistence

Field or control Description
Persist Data Toggle persistence data on or off.

Data is cleared either by an explicit clear action or by any setting change that controls
acquisition parameters.

Persistence

(Available only when Pattern
Sync is off.)

Infinite: Accumulates the data record points until you change an acquisition parameter or
explicitly clear the data, causing the display to be erased. Waveform data builds up as new
data records acquire.

Variable: Stores and displays accumulated data in the specified database until the user-
specified waveform count is surpassed. Each waveform accumulated beyond the count
removes the oldest waveform data in the database.

Enter the waveform count in the field when this option is selected.

Table continued…
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Field or control Description
Color Grading Use the drop-down menu to choose the color for the persistence data.

Table 4: Other

Field or control Description
Deskew Use the Deskew and field to set the values to compensate for skew (signal delay) between

channels.

Type in the deskew value, or click Set to Zero to reset the value to zero seconds.

External Attenuation Use this control to set a value matching the amount of attenuation applied externally, before
the signal enters the sampling module input.

Vertical channel deskew
Use the Deskew field in the Vertical settings menu to set the values to compensate for skew (signal delay) between
channels.

About this task
Critical timing measurements on multiple channels require that all channels be deskewed to compensate for signal timing
differences between channels.

Adjust deskew to add an independent, channel-based delay time to the horizontal position. (For the left position indicator,
this is the common trigger point to the first sample taken for each channel). Deskew is applied to the strobe drive and is
common to both channels in the module. It is therefore necessary to operate in a double-pass acquire on alternate triggers
(whenever the deskew values differ within channels in a module) to satisfy the requested deskew difference.

Waveform View configuration
Double click anywhere inside the Waveform View graph to open the Waveform View configuration window.
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You can also right click anywhere in the display for access to this menu and its functions.

Control Options Description
Display Mode Overlay Layers waveforms from active channels on top of each

other.
Tiled Shows each waveform in a separate segment of the

waveform view display.
Interpolation Sin(x)/x Calculates record points along a curve between the

actual acquired samples. This form of interpolation is
useful when acquiring rounded waveforms such as sine
waves. It is good for general-purpose uses, but may
introduce overshoot or undershoot in signals with fast rise
times. This interpolation is also useful for looking at high-
frequency signals, especially where the frequency
components are just below the Nyquist frequency.

Linear Calculates record points between actual acquired
samples using a straight-line fit. This interpolation is
useful for measuring waveforms with fast rise times, such
as pulse trains.

None No interpolation calculated.
Waveform Style Vectors Draws waveforms with lines between record points.

Dots Draws waveform record points as dots on the screen.
Waveform Intensity % field and up/down arrows Enter the desired intensity in % or click the up or down

arrows to adjust the intensity of the waveform vectors/
dots.

Graticule Style Grid Default style. Displays the graticule lines lightly, the time
(s) and power (W) scales, and the zero lines as most
visible.

Time Displays only the power (W) graticule lines and scale.
Full Displays all of the graticule lines with equal weight and

shows the time (s) and power (W) scales.
None Hides the graticule.

Graticule Intensity % field and up/down arrows Enter the desired intensity in % or click the up or down
arrows to adjust the intensity of the graticule lines.
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Add a note to a view
In the Add New... panel, click the Note button to add text labels to your waveform and plot views.

About this task
You can add notes to your waveforms. The text is not attached to the waveform. If you turn off the waveform source, the text
remains on the screen.

Procedure
1. In the Add New... panel, click the Note button. TSOVu adds a text box to the Waveform view.

Note: You can type long strings of text in the field.

2. You can click once in the note text later to change it if needed.

3. You can click and drag the text to position in wherever you need.
4. You can add multiple notes to the same waveform view.
5. To delete a note, right click on it and choose Delete.

Cursors
Use one of four different cursor types in the measurement view.

Before you can add a cursors, you must be acquiring a waveform. You should also ensure that the horizontal parameters
match the input signal and that horizontal parameters are set accurately. See the Horizontal configuration topic for details.

1. Click the Cursor button in the Add New... panel and cursors will be added to the active measurement view.

2. Double-click on one of the gray cursor readouts to open the cursors configuration window. You can also right-click on a
gray cursor readout or on the waveform and select Configure cursors.
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3. Configure the cursors as desired. See the following information for a description of settings and actions.

Moving readouts and cursors on the display

• Delete cursors by right-clicking on a cursor readout or the waveform display and selecting Turn off cursors.
• Right click at the location on the waveform where you want to place the cursor and then select Move Cursor A here,

Move Cursor B here, or Move Both Cursor here. This will move the specified cursor(s) to that location.
• Drag and move cursors vertically or horizontally directly on the graticule by clicking and dragging the cursor line.
• Move the cursor readouts by clicking and dragging them along the cursor lines.
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Configuration menu
Field or control Description
Display Toggle the cursor display On or Off.
Cursor Type Select one of the following the cursor types:

Waveform cursors measure vertical amplitude and horizontal time parameters
simultaneously at the point the cursor intersects a waveform. The cursor intersect point
tracks waveform amplitude changes.

V Bars are vertical cursors that measure horizontal parameters (typically time). They are
not associated with the waveform, but show the time position of the cursor in the waveform
record.

H Bars are horizontal cursors that measure amplitude. They are not associated with the
waveform, but show the amplitude position of the cursor.

V&H Bars cursors measure vertical and horizontal parameters simultaneously. They are
not associated with the waveform, but show the time and amplitude position of the cursors.

Source Select the waveform source to which you want to apply cursors.
Source Waveform Select whether to apply cursor configurations to a single source or multiple sources.

Same sets the A and B cursors to the same waveform source.

Split allows you to set cursors A and B to different waveform sources. The Cursor B
Source and Cursor A Source selections appear when Split is selected.

Cursor A X-Position Only available when Cursor Type is set to Waveform.

Set the position of cursor A on the x-axis, either by moving it with your mouse on the
display, or by changing the value settings in the configuration menu.

Cursor B X-Position Only available when Cursor Type is set to Waveform.

Set the position of cursor B on the x-axis, either by moving it with your mouse on the
display, or by changing the value settings in the configuration menu.

Cursor Mode Select the cursor mode.

Independent mode allows you to move each cursor separately.

Linked mode allows you to move both cursors at the same time.

The Acquisition configuration menu
Before setting up and starting acquisitions for signal analysis, configure horizontal settings first. Then use this procedure to
set the method used to acquire and display the signal.

Procedure
1. Double-click the Acquisition badge on the Settings bar to open the Acquisition configuration menu.
2. Select the acquisition method from the Acquisition Mode list. You can select Sample or Average. You can set the

number of samples to use in the average by typing in the field.
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3. Select from the Stop After options. If you leave the Run/Stop button enabled, then you need to use the Acquiring/
Stopped button at the lower right of the Settings bar to start and stop your acquisition. If you chose Condition, another
panel opens with more options.

4. In Stop After Condition, you can choose the Number of Acquisitions and set the number to however many
acquisitions you need.
The instrument stops acquiring data when it reaches the limit you set in Number of Acquisitions.

5. If you choose Average Complete, you must also have Average enabled for the Acquisition Mode.
In this case, the instrument stops acquiring data when it reaches the number of samples you specified in Average in the
Acquisition Mode section.

6. Click outside the menu to close it.

Use default setup
Use Default Setup to restore instrument settings to their factory defaults.

In the Menu bar, choose File > Default Setup. TSOVu returns the instrument to its factory default settings (horizontal,
vertical, scale, position, and so on).
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Measurements
Add Measurement

Use this menu to select measurements you want to enable. If you have purchased optional plug-ins, the related tab will
appear here.

Before you can add a measurement, you must be acquiring a waveform. You should also ensure that the horizontal
parameters match the input signal and that horizontal parameters are set accurately. See the Horizontal configuration topic
for details.

1. Click the Measure button in the Add New... panel.

The Add Measurement window will open to the last tab that you used. The listed tabs and measurements depend on
the installed measurement options and the selected signal source.
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2. To add a measurement, select the measurement type tab.
3. Select the input Source.
4. Select the measurement category, if present. For Pulse measurements, you can select Amplitude or Timing.
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5. Select a measurement and then click the Add button. The related measurement badge will be added to the Add New...
panel.

6. Double-click the measurement badge to open a configuration menu for that measurement and configure according to
your setup and needs.

Add Measurement menu fields and controls
 

Field or control Description
Measurement tabs The tabs along the top organize measurements by their type. The tabs that you see depend

on your installed plug-ins.

Measurement description Shows a graphic and short description of each measurement as you click on it. Use this
information to verify that the measurement is what you want.

Source Use the drop-down menu to select the measurement source. If the measurement requires
more than one source (for example, Delay), the menu shows two sources to set.

Add Click the Add button to enable the selected measurement. The measurement badge will
appear in the Add New... panel.

See these topics for more information:
Pulse Amplitude measurements

Pulse Timing measurements

PAM4 measurements (requires Option PAM4)
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Dark-level compensation
Dark-level compensation maximizes the accuracy of the extinction ratio and other optical automatic measurements.

If Dark Level Compensation is needed, run a module compensation.

Dark-level compensation maximizes the accuracy of the extinction ratio and other optical automatic measurements. Dark-
level compensation is not saved and is only valid for the selected bandwidth or filter path and the internal optical power
meter.

Delete a Measurement badge
Use this procedure to remove a Measurement badge from the Add New... panel.

Procedure
1. Right click on the banner of the Measurement badge that you want to delete. TSOVu opens a right-click menu.
2. Select Delete Meas # (where # is the number of the badge you wish to delete) to remove that badge from the Add

New ... panel.
You can also use the right-click menu to delete all measurement badges at once, or to configure the measurement that
you clicked on.

Pulse Amplitude measurements

High
High measures the top reference level of the waveform. The mean value (μ) displays in the High measurement badge.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Low
Low measures the bottom reference level of the waveform. The mean value (μ) displays in the Low measurement badge.
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Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values below the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
below the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population
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Amplitude
Amplitude measures the vertical difference between the high and low levels of the signal.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
value using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above and below the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above and below the midpoint. Since this statistical approach ignores short-term
aberrations (overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
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• Population

Max
Max measures the largest amplitude peak of the waveform over the measurement region.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Min
Min measures the smallest amplitude value of the waveform over the measurement region.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
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• Maximum
• Minimum
• Peak to peak
• Population

Mid
Mid measures the middle point between the maximum and minimum amplitude levels of the waveform over the
measurement region.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Mean
Mean measures the arithmetic mean of the waveform over the measurement region.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.
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Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Pk-Pk
Pk-pk measures the difference between the maximum and minimum amplitude values of the waveform over the
measurement region.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

AC RMS
AC RMS measures the root-mean-square, minus the DC component, of the waveform that is sampled within the
measurement region.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
Gating When enabled, gates constrain the measurement region to the area between the start

gate (Gate1) and the stop gate (Gate2).
Enable Toggle on/off to enable/disable gating.
Gate1 Start in %.
Gate2 Stop in %.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Pulse Timing measurements

Period
Period measures the collection of time intervals between two consecutive crossings on the same slope of the signal at the
mid-reference level.

Period = Tcross3 - Tcross1, where Tcross3 and Tcross1 are the times of the first two consecutive crossings on the same
slope at the mid-reference level.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
High/Low Tracking The High and Low values are the outermost amplitude values that can be used to

derive other reference measurement parameters for a waveform. This influences the
fidelity of amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Set mid-reference level. Default for Absolute is 0W. Default for Relative is 50% of the

pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population
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Frequency
Frequency measures the reciprocal of the period of the signal. This measurement is made on each cycle in the record.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.
High/Low Tracking The High and Low values are the outermost amplitude values that can be used to

derive other reference measurement parameters for a waveform. This influences the
fidelity of amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.
Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Set mid-reference level. Default for Absolute is 0W. Default for Relative is 50% of the

pulse amplitude.
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Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Rise
Rise measures the collection of time intervals between the low-reference level and the high reference level crossings on the
positive slopes of the signal.

Rise Time = TcrossH - TcrossL on rising edges, where:

TcrossH is the time of crossing of the high reference level.

TcrossL is the time of crossing of the low reference level.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level High Default for Absolute is 1W. Default for Relative is 80% of the pulse amplitude.
Ref Level Low Default for Absolute is -1W. Default for Relative is 20% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
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• Maximum
• Minimum
• Peak to peak
• Population

Measuring signals for which there are no measurements
When measuring signals like a PAM4 or NRZ signal, use the appropriate specialized measurements. See the below
example.

If the specialized measurement appropriate for the particular signal is not available, we recommend the generic Pulse
measurements that mostly follow the IEEE Std 181™. Doing this often requires adjustments of threshold levels, etc., in
order to yield the expected results.

For example: a Pulse type measurement of risetime of a PAM4 signal might give the result that exceeds 1 UI. This would be
because the Pulse type measurement does not expect the particular UI duration. It is not a specialized measurement that
expects data stream changing on clock boundaries (in unit intervals). Moreover, this general Pulse measurement does not
know that there are 4 signal levels. Therefore, if the signal presents a staircase pattern ( 0 à 1 à 2 à 3), then the Pulse
risetime measurement will simply measure the time from the 0 to 3 (10% of total amplitude to 90% of total amplitude) by
default, which is likely not the intended measurement. For example, gating can be used to coerce the intended behavior.

Fall
Fall measures the collection of time intervals between the high reference level and the low reference level crossings on the
negative slopes of the signal.

Fall Time = TcrossL - TcrossH on falling edges, where:

TcrossH is the time of crossing of the high reference level.

TcrossL is the time of crossing of the low reference level.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level High Default for Absolute is 1W. Default for Relative is 80% of the pulse amplitude.
Ref Level Low Default for Absolute is -1W. Default for Relative is 20% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
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• Maximum
• Minimum
• Peak to peak
• Population

Measuring signals for which there are no measurements
When measuring signals like a PAM4 or NRZ signal, use the appropriate specialized measurements. See the below
example.

If the specialized measurement appropriate for the particular signal is not available, we recommend the generic Pulse
measurements that mostly follow the IEEE Std 181™. Doing this often requires adjustments of threshold levels, etc., in
order to yield the expected results.

For example: a Pulse type measurement of risetime of a PAM4 signal might give the result that exceeds 1 UI. This would be
because the Pulse type measurement does not expect the particular UI duration. It is not a specialized measurement that
expects data stream changing on clock boundaries (in unit intervals). Moreover, this general Pulse measurement does not
know that there are 4 signal levels. Therefore, if the signal presents a staircase pattern ( 0 à 1 à 2 à 3), then the Pulse
risetime measurement will simply measure the time from the 0 to 3 (10% of total amplitude to 90% of total amplitude) by
default, which is likely not the intended measurement. For example, gating can be used to coerce the intended behavior.

Positive Cross
Positive Cross measures the time of the first positive crossing of the signal at the middle reference level in the measurement
region.

Positive cross = Tcross, where Tcross is the horizontal coordinate of the first positive crossing.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.
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Control Description
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Default for Absolute is 0W. Default for Relative is 50% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
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• Peak to peak
• Population

Negative Cross
Negative Cross measures the time of the first negative crossing of the signal at the middle reference level in the
measurement region.

Negative cross = Tcross, where Tcross is the horizontal coordinate of the first negative crossing.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Table continued…
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Control Description
Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Default for Absolute is 0W. Default for Relative is 50% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Positive Width
Positive Width measures the horizontal intervals between the crossings of the rising and falling edges of all positive pulses
at the middle reference level in the measurement region.

Positive width = Tcross2 - Tcross1, where Tcross1 and Tcross2 are the two consecutive horizontal crossings in the first
positive pulse.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Default for Absolute is 0W. Default for Relative is 50% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
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• Peak to peak
• Population

Negative Width
Negative Width measures the horizontal intervals between the crossings of the rising and falling edges of all negative pulses
at the middle reference level in the measurement region.

Negative width = Tcross2 - Tcross1, where Tcross1 and Tcross2 are the two consecutive horizontal crossings in the first
negative pulse.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 3%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Table continued…
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Control Description
Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Default for Absolute is 0W. Default for Relative is 50% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

RMS Jitter
RMS Jitter measures the time variance on the time crossings of data sampled at the mid-reference level of the first positive
or negative crossing. RMS Jitter is defined as one standard deviation of that variance.

RMS Jitter = Tcross, where Tcross is one standard deviation of the variance of crossing times for a histogram of the Tcross
values. Tcross is the horizontal coordinate of the first positive or negative crossing.

Controls
Control Description
Configure

Source Select the signal source.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 2%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Default for Absolute is 0W. Default for Relative is 50% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
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• Peak to peak
• Population

Pk-Pk Jitter
Pk-Pk Jitter measures the delta between the minimum and maximum of time crossings of data sampled at the mid-
reference level.

Pk-Pk Jitter = Tcrosspp, where Tcrosspp is the difference between the maximum crossing time and the minimum crossing
time for a histogram of the Tcross values. Tcross is the horizontal coordinate of the first positive or negative crossing.

This measurement requires the use of a waveform database. When this measurement is turned on, it will automatically set
the measurement system to use a waveform database, if available.

Controls
Control Description
Configure

Source Select signal source.
Label Customize label. This appears on the measurement badge.
High/Low Tracking The High and Low values are the amplitude values that can be used to derive other

reference measurement parameters for a waveform. This influences the fidelity of
amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Hysteresis Default is 2%. This is the level transition band around a crossing level that makes
crossing time less vulnerable to noise.

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Table continued…
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Control Description
Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value.
Gate2 Stop value.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Default for Absolute is 0W. Default for Relative is 50% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Delay
Delay measures the time interval between the first crossing of the middle reference level on the two sources of the
measurement.

Delay = Tcross(source1) - Tcross(source2), where Tcross is the first positive or negative crossing time at the mid-reference
level.

Controls
Control Description
Configure

Source 1 Select signal source 1.
Source 2 Select signal source 2.
Label Customize label. This appears on the measurement badge.

Table continued…
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Control Description
High/Low Tracking The High and Low values are the outermost amplitude values that can be used to

derive other reference measurement parameters for a waveform. This influences the
fidelity of amplitude and aberration measurements.

Selectable tracking algorithm settings:

Auto

Switches between methods. Auto method first attempts to calculate the high and low
values using the Mode method. Then, if the histogram does not show obvious
consistent high and low levels, it automatically switches to the Min/Max or Mean
method.

Mean

Sets the values statistically. Using a histogram, it selects the mean or average value
derived using all values above the midpoint.

Mode

Sets the values statistically. Using a histogram, it selects the most common value
above the midpoint. Since this statistical approach ignores short-term aberrations
(overshoot, ringing, etc.), Mode is the best setting for examining pulses.

Min/Max

Uses the highest and lowest values of the waveform record. This setting is best for
examining waveforms that have no large, flat portions at a common value, such as
sine waves and triangle waves (almost any waveform except for pulses).

Gating When enabled, gates constrain the measurement region to the area between the start
gate (Gate1) and the stop gate (Gate2).

Enable Toggle on/off to enable/disable gating.

By default, the algorithm searches forward from the Start Gate for the first rising edge,
but the direction of traversal can be reversed, so that the search will be backward from
the Stop Gate.

Gate1 Start value. NEC in %.
Gate2 Stop value. NEC in %.

Reference Levels
Reference method Select Absolute (W) or Relative (%).
Ref Level Default for Absolute is 0W. Default for Relative is 50% of the pulse amplitude.

Results
The following statistics are shown in the result table.

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population
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PAM4 measurements

RLM
The Level Mismatch Ratio (RLM) badge shows the vertical linearity of the signal. It is a measure of how close the four
symbol levels are to being equally spaced in the vertical dimension. RLM denotes the ratio; hence, it has no unit. This
measurement is defined in IEEE Ethernet (802.3) and OIF-CEI specifications.

Given the mean signal levels of PAM4 signal (V0, V1, V2 and V3; V0 refers to lowest signal level), the RLM is computed as
shown in the following graph from Intel®:

Vmid is computed as average of Vo and V3.
The mean signal levels are then normalized and offset adjusted so that Vmid corresponds to 0, V0 to −1, V1 to −ES1, V2 to
ES2, and V3 to 1.

Effective symbol levels are defined as follows:

RLM is computed as
RLM = min [(3 × ES1),(3 × ES2),(2 - 3 × ES1),(2 - 3 × ES2)]

Ideal eye will have an RLM equal to 1.

In an ideal eye, distance between all three levels remain same. Distance of V1 to Vmid is one third of distance between V0 to
Vmid (ES1 = 1/3). Distance of V2 to Vmid is again one third of distance between V3 to Vmid (ES2 = 1/3). This results in a best
case RLM equal to 1.

RLM = min ((3 x (1/3)), (3 x (1/3)), (2 - 3 x (1/3)), (2 - 3 x (1/3))) = min (1, 1, 1, 1) = 1

If ES1 or ES2 equals (2/3), then it is the worst case RLM equal to 0.

Level Deviation
Level Deviation is an eye related measurement. It represents the deviation of the vertical intervals between PAM4 levels
from perfectly equal spacing, where 0% represents perfect spacing.

Measurement
Given the mean signal levels of the PAM4 signal (V0, V1, V2, and V3; where V0 is the lowest signal level), the level
deviation is computed as follows:
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Level deviation in % = Level deviation * 100.0

Results
The level deviation value is shown in % for the selected waveform source.

Level Thickness
Level Thickness is an eye related measurement. It represents the vertical thickness of the symbol levels, where an ideal
signal with maximally open eyes would have a thickness of 0%.

Measurement
Given the level statistics of the PAM4 signal (mean and standard deviation), the level thickness is computed as follows:

Level thickness in % = Level thickness * 100.0

Results
The level thickness value is shown in % for the selected waveform source. In the result table for a single acquisition, the
max, min, mean will all be same value. Standard deviation will be zero.

Eye Width
The Eye Width badge shows width and threshold for each of the PAM4 eyes (upper, middle and lower). Eye width
represents widths of the PAM4 rendered eyes at the corresponding reference voltage.

Measurement
Given the levels of PAM4 signal, eye widths for all PAM4 eyes are computed as follows:

• Initial estimation of thresholds are computed for all PAM4 eyes using levels.
• Target SER = Maximum((1/Total symbols in the acquired signal), 1e-5)
• PDF eye of entire PAM4 signal is computed.
• PDF eye is separated into three sections corresponding to three PAM4 eyes.
• CDF/eye contours for all PAM4 eyes are computed using PDFs and target SER.
• CDFs are used to compute finer thresholds for each PAM4 eye.
• Eye width is computed for each eye at the thresholds obtained in the step.

Results
Width and threshold values for all three PAM4 eyes (upper, middle and lower) are given.

Eye Height
The Eye height badge shows height and offset for each of the PAM4 eyes (upper, middle and lower). Eye height represents
heights of the PAM4 rendered eyes, at the center of the unit interval, for the corresponding eye.
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Measurement
Given the levels of the PAM4 signal, eye heights for all PAM4 eyes are computed as follows:

• Initial estimation of thresholds are computed for all PAM4 eyes using levels.
• Target SER is computed as: Target SER = Maximum ((1/Total symbols in the acquired signal), 1e-5)

• PDF eye of entire PAM4 signal is computed.
• PDF eye is separated into three sections corresponding to three PAM4 eyes.
• CDF/eye contours for all PAM4 eyes are computed using PDFs and target SER.
• Maximum width of CDF/eye contour of middle eye is determined. Tmid is the time corresponding to center of maximum

width.
• Eye height is computed for each eye at the Tmid obtained in the previous step.

Results
Height and offset values for all three PAM4 eyes (upper, middle and lower) are given.

ES Levels
The Effective Symbol (ES) Levels , ES1 and ES2, are the average levels of the two center symbols.

Level
The Level measurements are symbol related and show the level measurements for each of the 4 levels for the selected
waveform source. It represents statistics of the signal levels for each PAM4 symbol. This measurement if defined in IEEE
Ethernet (802.3) and OIF-CEI specifications.
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Measurement
The PAM4 signal, if not already, it is processed to contain M samples per UI and aligned such that the 1st M samples of the
waveform correspond to the 1st PAM4 symbol; the 2nd M samples to the 2nd PAM4 symbol; etc.

For each symbol i, choose the center sample (index closest to M/2) from each UI: {vi1,vi2, …, viN}. The statistics of that
symbol are computed as:

Measurement Description
Minimum ISI point For each level (0 - 3) in the correlated eye, there exists a

horizontal position across the unit interval where the
standard deviation of the waveform voltage is minimized, so
that the level is thinnest at this point. (In theory there may be
more than one point for each level that matches this
description, but in practice that is seldom a problem.)

Time (e) For each level, the horizontal offset from the Minimum ISI
Point to the nominal center of the eye.

Amplitude (d) For each level, the mean voltage at the Minimum ISI Point
Standard deviation (σ) For each level, the standard deviation at the Minimum ISI

Point.

Controls
Enable Normalized Outputs to display normalized levels as the measurement output. When disabled, absolute levels are
displayed.

Results
The following statistics are shown for each of the four levels (L0, L1, L2, L4).

• Mean
• Standard deviation
• Maximum
• Minimum
• Peak to peak
• Population

Transmitter Transition Time

Transmitter Transition Time measures the slower of the time interval of the transition from 20% of OMAouter to 80%
OMAouter, or from 80% OMAouter to 20% OMAouter, for the rising and falling edges, respectively, for a PAM4 optical signal.
This measurement is defined in IEEE 802.3cd specification.

Transmitter Transition Time result will be returned in seconds.

Overshoot
Overshoot of a PAM4 signal measures the ratio of the difference in the amplitude of the signal at its 99% of full range and
level 3 to its difference between level 3 and level 0.

The levels of a PAM4 signal, from bottom most to top most, are Level 0, Level 1, Level 2, and Level 3.
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Measurement
Given the crossing time of the PAM4 eye and baud rate, the overshoot level(99% of the full range of the signal) is computed
over an aperture centered on PAM4 eye.

Overshoot = (Overshoot level - Level 3)/(Level 3 - Level 0)

Results
The overshoot value is a scalar.

Undershoot
Undershoot of a PAM4 signal measures the ratio of the difference of level-0 and the amplitude of the signal at its 1% of full
range to its difference between level 3 and level 0.

The levels of a PAM4 signal, from bottom most to top most, are Level 0, Level 1, Level 2, and Level 3.

Measurement
Given the crossing time of the PAM4 eye and baud rate, the overshoot level(1% of the full range of the signal) is computed
over an aperture centered on PAM4 eye.

Undershoot = (Level 0 - Undershoot level)/(Level 3 - Level 0)

Results
The overshoot value is a scalar.

TDECQ
TDECQ (transmitter and dispersion eye closure quaternary) is a measure of each optical transmitter's vertical eye closure
when transmitted through a worst case optical channel and equalized with the reference equalizer. This measurement is
defined in IEEE Ethernet (802.3) specifications.

Controls
Name Description
Extended search When enabled, searches for optimal FFE taps to optimize

the TDECQ value. Increases execution time.

When disabled, FFE taps are adopted more quickly, but may
be less optimal.

Vertical threshold adjust When enabled, sub-eye threshold levels are allowed to
adjust around OMAouter by a small range, per IEEE 802.3
allowance for computing optimal TDECQ.

When disabled, sub-eye threshold levels are determined by
OMAouter and AOP.

Autoset FFE When enabled, optimizes FFE taps to minimize TDECQ.

When disabled, user provided taps are used.

Table continued…
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Name Description
Always recalculate FFE When enabled, recalculates FFE taps at every run (when

Autoset FFE is enabled).

When disabled, uses FFE taps from previous calculation
when available.

FFE number of taps Enter number of FFE taps. Default is 5. Must be an odd
integer between 1 and 99.

FFE number of taps per UI Enter number of FFE taps per unit interval. Default is 1.
Range: 1,2

FFE maximum number of precursors Enter maximum number of precursor FFE taps. Must be less
than the number of FFE taps. Default is 2. Range: 1,2

Target SER Enter the target SER at which TDECQ is computed. Default
is 4.8E-4.

Histogram width Widths of the left and right histograms processed to
compute TDECQ.

Histogram spacing Horizontal spacing of the left and right histograms
processed to compute TDECQ. They are located
symmetrically across the UI center.

Vertical adjustment limit (%) Limit by which the vertical threshold can adjust relative to
OMAouter.

Scope noise Calibrated oscilloscope noise from the connected instrument
and module.

Read-only when the source is set to a live channel. Shows
the same value as in the vertical channel badge.

Editable when the source is set to a reference channel.

Scope noise is computed and it is a function of wavelength,
filter type, and bandwidth. It changes in the TDECQ
configuration whenever these parameters change.

Plots
You can enable one or both of the following plots. Eyes are displayed for 2 unit intervals.

Raw Eye

1. Displays the eye diagram of the raw signal before equalization.

FFE Equalized Eye

1. Displays the eye diagram of the FFE equalized signal.
2. Thresholds for each eye are shown as th1, th2, th3. These cannot be disabled.
3. Left and right histogram boxes optimized for TDECQ measurement are shown as LH and RH, respectively. These

cannot be disabled.
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Optimizing offset to ensure a valid measurement
For accurate TDECQ results, set the vertical offset on the modules according to the signal's AOP. See the Vertical
configuration topic for more detailed information about adjusting vertical offset.

Results
The following measurement results for the selected waveform source will show.

Result Unit
TDECQ dB
Ceq N/A

AOP W
Partial SER (ULeft) N/A
Partial SER (URight) N/A
Partial SER (MLeft) N/A
Partial SER (MRight) N/A
Partial SER (LLeft) N/A
Partial SER (LRight) N/A

OMAouter
OMAouter (outer optical modulation amplitude) measures the difference between the highest and lowest optical power
levels of a PAM4 optical signal.

(If Dark Level Compensation is needed, run a module compensation.)

Results
The OMAouter result shows in dBm.

Extinction Ratio
The Extinction Ratio (ER) measures the ratio of the highest and lowest optical power levels of a PAM4 optical signal.

(If Dark Level Compensation is needed, run a module compensation.)

Controls
Add or subtract a specified percentage (float %) from the measured ER value, adjusting for a better match between multiple
oscilloscopes. Range: [-100, 100]. Default: 0

Results
The ER result shows in dB.
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Menus and dialogs
Explore the following functions.

Add Results Table
Use this menu to add a table of all active measurement values. Results tables show values in a spreadsheet-like format.

1. You must have active measurements before you can use the Results Table. See the Add measurements topic for
details.

2. In the Add New ... panel, click the Results Table button to open the menu.

3. Click the Measurements button at the lower left of the Add Results Table.
4. Click the Add button on the right. This displays the selected table type. You can add as many tables as you want to the

screen. The Measurement Results table displays across the top of the Waveform View, showing the data for the active
measurement badges.

There are two set of statistics displayed: statistics of present acquisition and statistics across acquisitions.
5. You can configure what columns to display and column resolution.
6. You can click on the banner at the top of the Measurement Results table and drag it away from the TSOVu window. The

table detaches and you can put it anywhere on your desktop. You can do this with the Waveform View also.
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Save As
Use this procedure to save waveform data to a comma-separated values (csv) or Tektronix waveform data (wfm) file, for
later analysis or inclusion in reports. You can also save instrument setup information or sessions to files.

Procedure
1. In the Menu bar, choose File > Save As.

The Save As configuration menu opens. The menu shows the last type of file that you saved. You can save Waveforms,
Setups, and Sessions.

2. Look at the Save Location field. You can save files in the default location, or click Browse, or type, or paste a different
path location to save the file. This is true for saving setup and session information, as well.

3. File Name shows the name last used to save a file. The default name is Waveform000, or Setup000, or Session000
depending on the file type. To change the file name, click anywhere in the file name and change the name as you would
in any Save As dialog.

4. You can also click the Auto Increment File Name checkbox to enable or disable automatic incrementing of a file name.
Auto Increment File Name lets you save sequential files without needing to manually rename them each time. The count
number is added to the end of the file name.

• If Auto Increment File Name is enabled the Count defaults to 000 if there are no files at the specified location and
file name that already use incremented file names. If there are files at the save location that already use the
specified file name, and have already been saved using count increments, the Count field shows the next count
value that will be added to the file name when the file is saved.

• To change the starting count value, click in the Count field on the right and type to change the value.
5. Use the Save As Type dropdown menu to select the waveform data type you want from the list. For waveforms, you

can save the data to a comma-separated values (csv) file or Tektronix waveform data (wfm) file. You must save Setup
files as .set and Session files as .tss.

6. For Waveform files, you can use the Source dropdown menu to select the source of the waveform to save from the list.
You can save a single waveform or all waveforms.

7. For Setup files, you can click the checkbox to Include All References, which saves additional data for you.
8. Click Save to save the file.

Add a reference waveform
A reference waveform is a static waveform record displayed for comparison.

About this task
There is no set limit to the number of reference waveforms you can add to the Waveform View, other than system physical
memory constraints.
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Procedure
1. Click the Add New Ref button on the bottom of the display.
2. TSOVu opens the Recall window. Choose the reference file that you want. Like any File Explorer window, you can

navigate to a different directory if necessary. Click Open when you are ready.

The instrument adds the waveform to the Waveform view and adds a Reference badge on the bottom of the display on
the Settings bar. In this example, the channel 2 waveform is being compared with the reference waveform.

3. To open the configuration menu, double click the Ref1 badge.
Use the configuration menu to refine the waveform parameters. The displayed fields depend on the waveform and
selections made in the menu. Selection changes take effect immediately.

4. Click outside the menu to close it.

Draw a box for zoom or histogram
1. Double click the Draw a Box icon button to open the Draw A Box window.
2. Select Zoom or Histogram depending on what you want to define. The icon and mouse-over text change with the

selection and retain the selection until you change it.

3. Click in the graph and draw a box around the area of interest.
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4. See the Zoom elements topic for detailed information about the zoom view.
5. See the Add a histogram topic for detailed information about the histogram view.

Add a histogram
Use histograms to analyze a range of waveform data that you select. The instrument can display both vertical and horizontal
histograms.

Before you can add a histogram, you must be acquiring a waveform. You should also ensure that the horizontal parameters
match the input signal and that horizontal parameters are set accurately. See the Horizontal configuration topic for details.

1. At the bottom of the Add New... panel, view the draw a box button.

If it is gray, as shown here, double click on the button to open the Draw A Box window and select Histogram.
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2. If the Histogram icon button is blue, that means the histogram function is on and you can simply draw a box on the
waveform to define a new histogram.

If the button icon is different, then that means it is in Zoom mode. See the Zoom elements and Draw a box for zoom or
histogram topics for more information.

3. Draw a box on the area of the waveform for which you want to define the histogram. A Histogram badge will appear in
the Add New... panel. The badge shows several of the current histogram statistics. You can add as many histograms as
you need.

4. You can resize and reposition the box and use the mouse to drag the histogram box boundaries on screen to surround
the data that you want to analyze.

5. You can also double click on the Histogram badge and use the Histogram Configure menu to completely configure the
histogram.
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6. View all of the histogram statistics in the Statistics panel.

Menus and dialogs

78



Menus and dialogs

79



Zoom elements
Use the zoom elements to magnify waveforms to view signal details.

1. The Waveform overview shows the entire waveform record. Waveforms are shown in Overlay mode by default. You
can use the Waveform Configuration menu to change to Tile mode.

2. The area of interest shows the area of the waveform that is magnified and shown in the graticule area below. You can
click and drag this box to change the area of interest.

Note: Moving the area of interest, or changing its position, does not change the horizontal time base settings.
3. The Zoom icon in the upper right corner of the Waveform View hides or shows the zoom view without turning zoom off.

4. The Draw a box button allows you to draw a box around an area of interest. Double click on this button to open the
Draw a Box window and toggle the Draw A Box icon between a zoom box and a histogram box. (See the Draw a box for
zoom or histogram topic for details.)

5. The Zoom View shows the zoomed area of the waveform, as defined by the Zoom Box, in the Zoom Waveform Record
View. Use click and/or drag options in the zoom view to change the zoomed area of interest.

6. Use the Horizontal Zoom Scale bar controls to adjust the horizontal scale of the zoom area. You can enter a value
directly into the field or click the + or - buttons to zoom in and out horizontally.

Click the X on the Horizontal Zoom Scale bar to turn off zoom mode. Doing this will delete the zoom configurations.

Cursors
Use one of four different cursor types in the measurement view.

Before you can add a cursors, you must be acquiring a waveform. You should also ensure that the horizontal parameters
match the input signal and that horizontal parameters are set accurately. See the Horizontal configuration topic for details.

1. Click the Cursor button in the Add New... panel and cursors will be added to the active measurement view.
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2. Double-click on one of the gray cursor readouts to open the cursors configuration window. You can also right-click on a
gray cursor readout or on the waveform and select Configure cursors.

3. Configure the cursors as desired. See the following information for a description of settings and actions.

Moving readouts and cursors on the display
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• Delete cursors by right-clicking on a cursor readout or the waveform display and selecting Turn off cursors.
• Right click at the location on the waveform where you want to place the cursor and then select Move Cursor A here,

Move Cursor B here, or Move Both Cursor here. This will move the specified cursor(s) to that location.
• Drag and move cursors vertically or horizontally directly on the graticule by clicking and dragging the cursor line.
• Move the cursor readouts by clicking and dragging them along the cursor lines.

Configuration menu
Field or control Description
Display Toggle the cursor display On or Off.
Cursor Type Select one of the following the cursor types:

Waveform cursors measure vertical amplitude and horizontal time parameters
simultaneously at the point the cursor intersects a waveform. The cursor intersect point
tracks waveform amplitude changes.

V Bars are vertical cursors that measure horizontal parameters (typically time). They are
not associated with the waveform, but show the time position of the cursor in the waveform
record.

H Bars are horizontal cursors that measure amplitude. They are not associated with the
waveform, but show the amplitude position of the cursor.

V&H Bars cursors measure vertical and horizontal parameters simultaneously. They are
not associated with the waveform, but show the time and amplitude position of the cursors.

Source Select the waveform source to which you want to apply cursors.
Source Waveform Select whether to apply cursor configurations to a single source or multiple sources.

Same sets the A and B cursors to the same waveform source.

Split allows you to set cursors A and B to different waveform sources. The Cursor B
Source and Cursor A Source selections appear when Split is selected.

Cursor A X-Position Only available when Cursor Type is set to Waveform.

Set the position of cursor A on the x-axis, either by moving it with your mouse on the
display, or by changing the value settings in the configuration menu.

Cursor B X-Position Only available when Cursor Type is set to Waveform.

Set the position of cursor B on the x-axis, either by moving it with your mouse on the
display, or by changing the value settings in the configuration menu.

Cursor Mode Select the cursor mode.

Independent mode allows you to move each cursor separately.

Linked mode allows you to move both cursors at the same time.

Add a note to a view
In the Add New... panel, click the Note button to add text labels to your waveform and plot views.

About this task
You can add notes to your waveforms. The text is not attached to the waveform. If you turn off the waveform source, the text
remains on the screen.
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Procedure
1. In the Add New... panel, click the Note button. TSOVu adds a text box to the Waveform view.

Note: You can type long strings of text in the field.

2. You can click once in the note text later to change it if needed.

3. You can click and drag the text to position in wherever you need.
4. You can add multiple notes to the same waveform view.
5. To delete a note, right click on it and choose Delete.

Reference waveform configuration menu
Use this menu to configure display settings for a reference waveform.

To open a reference waveform configuration menu, you must first have added a reference waveform using the Add New Ref
button, then selecting a reference waveform from the list of available waveforms. After the reference waveform displays on
the Waveform View screen, on the Settings bar, double-click the Ref badge.
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Reference waveform configuration menu fields and controls
 

Field or control Description
Display Displays the reference waveform or turns the display off. Reference waveforms are shown

in lighter colors than the souce waveforms.
Vertical Scale Use the up and down arrows to set the vertical scale.
Units Set the units label that you want to display on the vertical scale.
Position Set the vertical position of the waveform by typing a new value in this field.
Set to 0 Click to reset the vertical position to 0.
Label Adds a label to the waveform. Put the cursor in this field and type the text. The label text is

the same color as the waveform.

You can double-click a label to open a menu that will allow you to change the text, or you
can open the Reference configuration menu for that label and change the text there.

Record Length Read-only text that shows the sample rate and record length values of the reference
waveform.

Table continued…
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Field or control Description
Reference File Shows the path and file name of the current Reference waveform.

Use the dropdown arrow to choose another reference waveform, or click the browse button
to navigate to a new reference waveform.

The dropdown arrow shows a list the twenty most recently accessed reference waveform
files.

Browse Opens the Browse Waveform File dialog. Use this dialog to navigate to and select a
waveform file to load.

Add a label
About this task
Labels appear in the Waveform View and as the name of the designated measurement badge.

Before you begin
Prerequisite: You must first have added a measurement. See the Add measurement topic for details.

Procedure
1. Under the Add New... panel, double-click a measurement badge to open its configuration window.
2. Select the Configure panel.
3. Click the Label field and enter the desired text.
4. Click anywhere outside the configuration menu to close it.

Diagnostics
Shows the status of the power-on self test and allows you to export log files.

See also: TSOVu user interface
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Set the graticule style and intensity
Use this procedure to set the graticule (display grid) style and intensity.

Procedure
1. Double-click on an open graticule area to open the Waveform View configuration menu.
2. Click the Graticule Style field to select a graticule style from the list.

Grid provides a grid, cross hairs, and frame on the waveform view.

Time provides a vertical grid of time marks, cross hairs, and frame on the waveform view.

Full shows a frame and a grid on the waveform view. This style is useful for making quick, full-screen measurements
with cursors and automatic readouts when cross hairs are not needed.

None provides a frame without a grid and cross hairs.
3. Use the up and down arrow buttons to set the intensity, that is, brightness, of all graticules.

Note: Changing the graticule intensity also changes the intensity of vertical scale readouts and horizontal time
readouts on the screen. Graticule intensity does not change the intensity of note text on the screen.
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Trigger
Trigger settings

Use the Trigger menu to define the channel or signal conditions on which to trigger the oscilloscope.

Operate the instrument either in free run mode, direct, or use a clock signal that is synchronized to data as a trigger.

External Clock Input/Prescale Trigger. To use this trigger type, you must connect the trigger signal to the Clock Prescale
Input.

Free Run/Untriggered Phase Ref. Sets the instrument to free run (untriggered) acquisition mode. Use Free Run to quickly
validate signal presence and amplitude of input signals. Select this Trigger Source to operate in Untriggered Phase
Reference mode.

Double-click the Trigger badge to access the Trigger Settings menu.

Use the Trigger Holdoff controls to set the holdoff.

You cannot change the Clock Frequency. This read-only field shows the current clock frequency.
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